THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB's public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED "AS IS" WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses in illustrative content is unintentional and coincidental.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL: http://www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company. (1110R)

© 2013 Cisco Systems, Inc. All rights reserved.
CONTENTS

Preface ix
  Purpose ix
  Audience ix
  Organization ix
  Related documentation x
    Related information xi
    Related information for Agent Greeting xi
  Conventions xi
  Documentation and service requests xii
    Documentation Feedback xii

CHAPTER 1 Agent Greeting requirements 1
  System Requirements and Functional Limitations 1
    Software Requirements 1
    Protocol Requirements 2
  Agent Greeting Phone Requirements (for Local Agents Only) 3
  Configuration Requirements 3
  Functional Limitations 4

CHAPTER 2 How Agent Greeting Works 7
  How Agent Greeting Files Are Played 7
    How Agent Greeting Files Are Named and Saved 7
    How to Limit the Number of Greetings an Agent Can Have 8
  Login Name Changes and Agent Greeting 8
  Agent Greeting Call Flow 8
  Reporting 9
    Greeting Call Statistics 9
Peripheral Call Types for Agent Greeting  9

Serviceability  9

Component Failure and Agent Greeting  10

Failover of ICM and CTI OS Server  10

Failover of VRU PG  10

Failure to Access CVP Media Server  10

Failure to Access CVP VXML Server  10

Agent Desktop Closes Unexpectedly  10

Whisper Announcement with Agent Greeting  11

CHAPTER 3

Deploy Agent Greeting  13

Agent Greeting deployment tasks  13

Schedule the script  14

Configure Media Server for Agent Greeting  14

Media server hardware and network requirements  15

Prepare a Media Server  15

How greeting files are recorded and served  17

Add and Configure Media Servers in CVP  18

Republish .tel Scripts to VXML Gateway  18

Set Cache Size on VXML Gateway  19

Create Voice Prompts for Recording Greetings  19

Built-in Recording Prompts  20

Example Record Greeting Prompts  20

Configure Call Types  20

Configure Dialed Numbers  20

Define Network VRU Scripts for Agent Greeting  21

Import example Agent Greeting scripts  22

Agent Greeting Example Routing Scripts  23

Test Agent Greeting File Path  24

Modify the CCE Call Routing Scripts to Use Play Agent Greeting Script  25

Specify AgentGreetingType Call Variable  25

Scripting Agent Greeting for multiple customers  26

Configure custom dialed number for Agent Greeting play  26

Configure custom dialed number for Agent Greeting record  26

Include Agent Greeting Controls in Agent Desktops  27
Agent Greeting Scripts 27
   Agent Greeting Recording Script 27
      RecordAgentGreeting Micro-Application 28
   Agent Greeting Record Script Nodes 28
   Specify Media Server in Routing Scripts 30
   Specify Greeting File Locale and Application Directories in Routing Scripts 31
      Verify Length for Media Server Locale and Application Directory Variables 32
   Descriptive Agent Greeting Type Strings 32
   Agent Greeting Play Script 33

CHAPTER 4
Using Agent Greeting with Your CTI OS Agent or Supervisor Desktop 35
   Record a Greeting 35
   Delete Greeting 36
   Review Greetings 36
   Enable or Disable Greeting Play 36
   Agent Greeting with the Outbound Agent Desktop 36
   Agent Greeting During Transfers and Conferences 37
      Agent desktop closes 37

CHAPTER 5
Using Agent Greeting with your CAD agent or supervisor desktop 39
   Record greeting 39
   Add customized task button in the CAD agent for recording an Agent Greeting 39
      Disable Agent Greeting 40

CHAPTER 6
Agent Greeting in a parent-child deployment 43
   Configuration tasks 43
   Configure routing scripts 44
      Configure AG.ICMS routing script 44
      Configure PAG.ICMS routing script 44
      Configure RECORD_AG.ICMS routing script 45

CHAPTER 7
Troubleshooting Agent Greeting 47
   Debugging Agent Greeting scripts 47
   Monitoring Agent Greeting 47
   Frequently asked questions 47
CHAPTER 8  Whisper Announcement capabilities  49
System requirements and functional limitations  49
   Software requirements  49
   Hardware requirements  50
   Configuration requirements  50
   Functional Limitations  52

CHAPTER 9  How Whisper Announcement works  53
   Whisper Announcement Audio File  53
   While a Whisper Announcement Is Playing  53
   Whisper Announcement with Transfers and Conference Calls  53
   Whisper Announcement call flow  53
   Whisper Announcement Reporting and Serviceability  54
       Component failure and Whisper Announcement  55
          Failover of ICME and CTI OS server  55
          Failure to access CVP media server  55
   Whisper Announcement in Agent Desktop Software  55
   Using Agent Greeting with Whisper Announcement  55

CHAPTER 10 Deploy Whisper Announcement  57
Deployment tasks  57
   Create Whisper Announcement Audio Files  57
   Deploy Whisper Announcement Audio Files to Media Server  58
      Using a Default Media Server  58
   Configure Whisper Service Dialed Numbers  58
      Configure Dialed Numbers  59
      Configure Ringtone Dialed Number  59
         Dialed Number in the Dial-Peer  59
   Add Whisper Announcement to Routing Scripts  60
      Specify WhisperAnnouncement Call Variable  60
      Specify Unified CVP Media Server Information  60
         Specify Whisper File Locale and Application Directories  61
            Specify locale directory  61
            Specify application directory  61
Variable length for media server locale and application directory variables 61

Test Whisper Announcement File Path 62
Other Script Settings That Are Required for Whisper Announcement 62
Configure Whisper Announcement Play Length 62
Fail-Safe Timeout for Whisper Announcement in Unified CCE 62
Whisper Announcement Sample Scripts 63
WA.ICMS Script 63
WA_AG.ICMS Script 64
Import Sample Whisper Announcement Scripts 64

CHAPTER 11
Whisper Announcement in a parent-child deployment 67

Functional limitations 68
Configure Whisper Announcement in parent-child deployment 68
Configure user.whisper and user.media.id ECC variables 69
Enable Whisper Announcement 69
Configure routing script 70
Upload Whisper prompt .wav file 71
Upload ringtone 71
Configure Network Hold Audio source 72
Configure timeout for Whisper Announcement 72
Preface

Purpose

This manual provides an overview of the Agent Greeting and Whisper Announcement features, and describes how to configure and use these features.

Audience

This manual is for supervisors and agents who want to use the Agent Greeting and Whisper Announcement features with the Cisco Contact Center software.

Organization

The manual is divided into the following chapters.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Greeting requirements, on page 1</td>
<td>This chapter provides an overview of Agent Greeting.</td>
</tr>
<tr>
<td>How Agent Greeting Works, on page 7</td>
<td>This chapter describes how Agent Greeting works.</td>
</tr>
<tr>
<td>Deploy Agent Greeting, on page 13</td>
<td>This chapter includes information about how to deploy and configure Agent Greeting.</td>
</tr>
</tbody>
</table>
### Related documentation

Documentation for Cisco Unified ICM/Unified Contact Center Enterprise & Hosted (United ICM/CCE/CCH), as well as related documentation, is accessible from Cisco.com at


- For documentation for these Cisco Unified Contact Center Products, go to
  - click on Voice and Unified Communications, then click on Cisco Unified Contact Center Products or Cisco Unified Voice Self-Service Products, then click on the product/option you are interested in.

- For troubleshooting tips for these Cisco Unified Contact Center Products, go to http://docwiki.cisco.com/wiki/category:Troubleshooting, then click the product/option you are interested in.

- Also related is the documentation for Cisco Unified Communications Manager, which can also be accessed from http://www.cisco.com/cisco/web/psa/default.html?mode=prod

---

### Chapter Table

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Agent Greeting with Your CTIOS Agent or Supervisor Desktop, on page 35</td>
<td>This chapter includes information about how to use Agent Greeting with CTIOS agent or supervisor desktop.</td>
</tr>
<tr>
<td>Using Agent Greeting with your CAD agent or supervisor desktop, on page 39</td>
<td>This chapter includes information about how to use Agent Greeting with your CAD agent or supervisor desktop</td>
</tr>
<tr>
<td>Agent Greeting in a parent-child deployment, on page 43</td>
<td>This chapter describes how to use Agent Greeting in a parent/child deployment.</td>
</tr>
<tr>
<td>Troubleshooting Agent Greeting, on page 47</td>
<td>This chapter includes troubleshooting tips and frequently asked questions.</td>
</tr>
<tr>
<td>Whisper Announcement capabilities, on page 49</td>
<td>This chapter provides an overview of Whisper Announcement.</td>
</tr>
<tr>
<td>How Whisper Announcement works, on page 53</td>
<td>This chapter describes how Whisper Announcement works.</td>
</tr>
<tr>
<td>Deploy Whisper Announcement, on page 57</td>
<td>This chapter includes information about how to deploy and configure Whisper Announcement.</td>
</tr>
<tr>
<td>Whisper Announcement in a parent-child deployment, on page 67</td>
<td>This chapter describes how to use Whisper Announcement in a Parent/Child deployment.</td>
</tr>
</tbody>
</table>

• The Product Alert tool can be accessed through (login required) http://www.cisco.com/cgi-bin/Support/FieldNoticeTool/field-notice

Related information

See the following sources for related information:

• For information about phone compatibility, see the http://www.cisco.com/en/US/products/sw/custcosw/ps1844/products_device_support_tables_list.html Unified CCE compatibility documentation.

• For information about how to configure your CVP media server, VXML gateway, Call Server, ECC variables, SIP subsystem, and how to create Network VRU scripts for CVP micro-apps, see the CVP 8.5(1) documentation.

• For load performance and sizing information, see the Unified CCE SRND Guide.

• For troubleshooting information, see the Cisco DocWiki.

Related information for Agent Greeting

See the following sources for additional information related to Agent Greeting:

• For information about how to include Agent Greeting controls on your agent desktop, see the CTI OS Developer’s Guide.

• For information about Mobile Agent with Agent Greeting, see the Mobile Agent Guide for Unified CCE.

• For information about how to configure Translation Routes, see the ICM configuration guide.

Conventions

This manual uses the following conventions.

<table>
<thead>
<tr>
<th>Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boldface type is used for user entries, keys, buttons, and folder and submenu names.</td>
<td>Choose <strong>Edit &gt; Find</strong> from the ICM Configure menu bar.</td>
</tr>
<tr>
<td>Italic type indicates one of the following:</td>
<td></td>
</tr>
<tr>
<td>• A newly introduced term</td>
<td>• A skill group is a collection of agents who share similar skills.</td>
</tr>
<tr>
<td>• For emphasis</td>
<td>• Do not use the numerical naming convention that is used in the predefined templates (for example, persvc01).</td>
</tr>
<tr>
<td>• A generic syntax item that you must replace with a specific value</td>
<td>• IF (condition, true-value, false-value)</td>
</tr>
<tr>
<td>• A title of a publication</td>
<td></td>
</tr>
</tbody>
</table>
The Save command from the File menu is referenced as File > Save.

### Documentation and service requests

For information on obtaining documentation, submitting a service request, and gathering additional information, see the monthly What's New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:


Subscribe to the What's New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently supports RSS version 2.0.

### Documentation Feedback

You can provide comments about this document by sending e-mail to the following address:

mailto:ccbu_docfeedback@cisco.com

We appreciate your comments.
Agent Greeting requirements

The Agent Greeting feature lets an agent record a message that plays automatically to callers when they connect to the agent. The greeting message can welcome the caller, identify the agent, and include other useful contextual information. With Agent Greeting, each caller can receive a clear, well-paced, language-appropriate, and enthusiastic introduction. Another benefit is that it saves the agent from having to repeat the same introductory phrase for each call. It also gives the agent a moment to review the desktop software screen pop-ups while the greeting plays.

The process of recording a greeting is much the same as recording a message for voice mail. Depending on how the call center is set up, agents may be able to record different greetings that play for different types of callers (for example, an English greeting for English speakers or an Italian greeting for Italian speakers).

By default, greeting play is enabled when agents log in to their agent desktop. Agents can turn greeting play off and on as necessary.

- System Requirements and Functional Limitations, page 1

System Requirements and Functional Limitations

To use Agent Greeting, your system must meet these baseline requirements.

Software Requirements

These software pieces must be in place to deploy Agent Greeting.

<table>
<thead>
<tr>
<th>What</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software versions</td>
<td>To use Agent Greeting, your Unified CCE deployment must be running:</td>
</tr>
<tr>
<td></td>
<td>• Unified CCE 8.5(1) or later</td>
</tr>
<tr>
<td></td>
<td>• Unified CVP 8.5(1) or later</td>
</tr>
<tr>
<td></td>
<td>• Unified CTI OS 8.5(1) or later</td>
</tr>
<tr>
<td></td>
<td>• Unified CM 8.5(1) or later</td>
</tr>
<tr>
<td>What</td>
<td>Requirement</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Deployment models</td>
<td>Agent Greeting is supported with Enterprise deployments of Unified CCE with CVP only; it is not supported with hosted deployment models.</td>
</tr>
<tr>
<td></td>
<td>Agent Greeting in Parent/Child deployments and Agent Greeting for mobile agents both require Unified CCE, Release 8.5(2) or later.</td>
</tr>
<tr>
<td></td>
<td>Agent Greeting for Parent/Child is only supported for a very specific Parent/Child configuration, where calls are queued at a CCX (IP-IVR) on the child system PG, and requires a dedicated CVP at the child on a dedicated VRU PG to provide the agent greetings. Agent Greeting in Parent/Child configurations must be approved by the Cisco Assessment to Quality (A2Q) process and require Cisco Design Mentoring Service to assure that the deployment model is designed and sized correctly to support the Agent Greeting feature.</td>
</tr>
<tr>
<td>Agent types</td>
<td>Agent Greeting is supported for inbound agents and blended outbound agents when they receive inbound calls.</td>
</tr>
<tr>
<td>Agent desktops</td>
<td>Agent Greeting is supported with CTI OS desktops created using the COM or C++ CILs. CTI OS includes Active X controls that let you integrate Agent Greeting buttons (Enable/Disable Greeting, Record Greeting) into the desktop. For more information, see the CTI OS developer documentation.</td>
</tr>
<tr>
<td></td>
<td>Agent Greeting is supported with CAD, VB, Java, and .NET desktops with these limitations:</td>
</tr>
<tr>
<td></td>
<td>• There is no support for Agent Greeting controls in the desktop.</td>
</tr>
<tr>
<td></td>
<td>• Agents cannot enable or disable the feature. For more information about CAD, see the section on using Agent Greeting with CAD.</td>
</tr>
<tr>
<td></td>
<td>• Greeting recording calls made using CTI OS are assigned the Peripheral Call Type value 40. (AGENT_GREETING_RECORDING). Greeting recording calls made using CAD, VB, Java, or .NET are assigned the Peripheral Call Type value 10 (AGENT_INSIDE).</td>
</tr>
<tr>
<td></td>
<td>• PG capacity is reduced (CAD only).</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>For more information about Agent Greeting with CAD, see Using Agent Greeting with your CAD agent or supervisor desktop, on page 39</td>
</tr>
</tbody>
</table>

**Protocol Requirements**

These protocol and encoding pieces must be in place to deploy Agent Greeting.
### Agent Greeting Phone Requirements (for Local Agents Only)

Agent Greeting is available to agents and supervisors who use IP Phones with Built-in-Bridge (BiB). These agents are typically located within a contact center. Phones used with Agent Greeting must meet these requirements:

- The phones must have the BiB feature.

**Note**

If you disable BiB, the system attempts to use a conference bridge for agent greeting call flow and a warning event is raised.

- The phones must be running the firmware version CM 8.5(1) or greater. (In most cases, phone firmware is upgraded automatically when you upgrade your Unified CM installation.)

- See the [Unified CCE Compatibility Matrix](#) for the list of supported Cisco Unified Call Center phone models.

### Configuration Requirements

The following configuration components must be in place to deploy Agent Greeting.

<table>
<thead>
<tr>
<th>Where</th>
<th>What</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unified CM</td>
<td>For phones that use Agent Greeting, you must set the Built-in-Bridge option to On or Default (if the value of Default is On). To verify, in Unified CM Administration, select <strong>Device &gt; Phone &gt; Built in Bridge</strong>.</td>
</tr>
</tbody>
</table>
Agent Greeting is supported with Type 10 Network VRUs only. (Type 10 is required to allow CVP to control the call). If your current Unified CCE deployment is not configured for a Type 10 VRU, you must modify it accordingly.

Agent Greeting requires at minimum three expanded call variables.

- **user.microapp.ToExtVXML**: This is used twice in an Agent Greeting record script: the first time is to queue the Unified CVP RecordAgentGreeting application; the second time is to tell the recording application where to save greeting files. Configure it as an array with size 3. Use the Unified CCE Administration tool to ensure this variable includes these settings: Maximum Length - 100 and Enabled.

- **user.microapp.app_media_lib**: This is required in Agent Greeting record and play scripts to specify the dedicated directory on the media server where your greeting audio files are stored. Maximum Length - 100 andEnabled.

- **user.microapp.input_type**: This is required in Agent Greeting record scripts to limit the allowable input type to DTMF. Maximum Length - 100 and Enabled.

No other expanded call variables are needed if you serve your files from the Unified CVP default media server, and your files are in the media server default locale directory ("<web_server_root>\en-us\app"). However, if you store your files in a location other than these defaults, you must use one or more of the expanded call variables in the next row in your scripts.

To make these variables available to your script authors, confirm that they are defined in the Unified CCE Configuration Manager tool. For instructions about defining ECC variables for CVP, see the Configuration and Administration Guide for Unified CVP.

- **user.microapp.media_server**: Use to identify the Unified CVP media server if it is other than the default.

- **user.microapp.locale**: Use to specify the name of the locale directory on the media server if it is other than the default ("en-us").

- **user.microapp.UseVXMLParams**: Required in your record script if you include the user.microapp.media_server variable. It tells the external VXML recording script to use the name/value pair of the application that you pass in the user.microapp.ToExtVXML variable.

Your Unified CVP installation must include the Unified CVP VXML Server and the Unified CVP Call Server. The VXML Server must be deployed and connected to the Call Server using the configuration in the CVP Operations Console.

**Functional Limitations**

Agent Greeting is subject to these limitations.
• Agent Greeting is not supported with outbound calls made by an agent. The announcement plays for inbound calls only.

• Only one Agent Greeting file plays per call.

• Supervisors cannot listen to agent recorded greetings.

• Agent Greetings do not play when the router selects the agent via a label node.

• Out of the box, the default CTI OS Toolkit Agent desktop includes the Agent Greeting buttons. If Agent Greeting is not configured, the Agent Greeting buttons do not execute any functionality. If you use the default desktop but do not plan to use Agent Greeting, you should remove them.

• Silent Monitoring (CTI OS and Unified CM-based) is supported with Agent Greeting with this exception: For Unified-CM based Silent Monitoring, supervisors cannot hear the greetings themselves. If a supervisor clicks the Silent Monitor button in their CTI OS desktop while a greeting is playing, a message displays stating that a greeting is playing and to try again shortly.
Functional Limitations

Agent Greeting requirements
How Agent Greeting Works

This chapter describes how the Agent Greeting feature works.

• How Agent Greeting Files Are Played, page 7
• Reporting, page 9
• Serviceability, page 9
• Whisper Announcement with Agent Greeting, page 11

How Agent Greeting Files Are Played

When an agent answers a customer call, the Agent PIM sends a route request to the router and gets the route response back. The Agent PIM tells Unified CM to connect to CVP. When CVP answers the call, Unified CM allocates the BiB resource for the agent phone. The router sends CVP a Run Script request. In response, CVP tells the VXML gateway to play the requested Agent Greeting media file. The VXML gateway plays the media file to the BiB for the phone. Both the agent and customer hear the greeting.

How Agent Greeting Files Are Named and Saved

Agent Greeting files are named automatically at the time an agent records and saves them. The file name is a concatenation of the agent sign in name and the current value of the Agent Greeting Type variable in the Agent Greeting record script.

For example, the sign in name is agent123 and the agent presses 1 to record a greeting. In the Agent Greeting record script, when the agent presses 1, the value of the Agent Greeting Type variable is set to French. The file is saved as agent123_French.wav

Note

Sign in name is the Login Name configured for the agent in the Unified CCE Configuration Manager Agent Explorer tool.
How to Limit the Number of Greetings an Agent Can Have

Unified CCE does not impose a limit on the number of concurrent greetings you can allow your agents to have. Practically speaking, though, the number of keys on your agents' dial pads sets an upper bound of nine. You can further limit the number of greetings in the Network VRU script that prompts agents to select the greeting they want to record. For example, in that script, a configuration parameter value of 1-3 allows three greetings, 1-5 allows 5 greetings, and so on.

Login Name Changes and Agent Greeting

The association of the agent with the greeting files is based on Login Name. If an agent Login Name changes for any reason, that association is lost and the agent must re-record the greetings. Conversely, if a new agent is assigned a pre-existing Login Name, that agent is automatically associated with any existing greetings for that name.

Agent Greeting Call Flow

Following is an Agent Greeting call flow diagram accompanied by a description of the steps.

1-2. After the agent answers the customer call, the Agent PIM sends a route request to the router and gets the route response back.
3. Agent PIM instructs Unified CM to connect to the VRU to add media to the call.
4. Unified CM makes the server call to CVP. After CVP answers the call, Unified CM allocates the agent phone's BIB resource.

5 - 12. CVP gets a Run Script request from the router.

13. CVP instructs the VXML gateway to play the agent greeting media file. VXML voice gateway plays the media file to Phone's BIB. Agent and customer both hear the greeting.

**Reporting**

In agent, skill group, and Precision Queue reports, greeting time is not specifically broken out. The period during which the greeting plays is reported as talk time. Record time is counted as an internal call by the default skill group.

Calls that involve Agent Greeting consist of two call legs: the inbound call from the customer and the call to Unified CVP for the greeting. Both of these legs have the same RouterCallKeyDay and RouterCallKey values in the TCD and RCD tables in the database. You can use these values to link the two legs together for reporting purposes.

**Greeting Call Statistics**

To view greeting call statistics, create a separate call type and associate it with the routing script that plays agent greeting. New CUIC templates for the agent greeting call type are created based on the data in the existing Call_Type_Real_Time and Call_Type_Interval table in the database.

**Peripheral Call Types for Agent Greeting**

There are two peripheral call types specific to Agent Greeting that you can use to track and report on the feature.

- Call Type 39: Play Agent Greeting. Route request to play an Agent Greeting.
- Call Type 40: Record Agent Greeting. Agent call for recording an Agent Greeting.

**Note**

Greeting recording calls made using CAD are assigned the Peripheral Call Type value 10 (AGENT_INSIDE).

Extra TCDs and RCDs are generated for the agent greeting call leg, and they can be linked to the first call leg by the same RouterCallKeyDay and RouterCallKey.

**Serviceability**

Serviceability for Agent Greeting includes SNMP events captured by your Network management software that indicate reasons for greeting failures and counters to track the number of failed greeting events.
There is no counter for the number of failed agent greeting calls.

When system components fail, Agent Greeting may be impacted. For example, if a requested greeting audio file cannot be found for any reason, the call proceeds normally without the Agent Greeting. To view Agent Greeting troubleshooting tips, see [http://docwiki.cisco.com/wiki/Troubleshooting_Tips_for_Unified_CCE_8.5](http://docwiki.cisco.com/wiki/Troubleshooting_Tips_for_Unified_CCE_8.5).

### Component Failure and Agent Greeting

This section describes the most common failure types for the Agent Greeting feature.

#### Failover of ICM and CTI OS Server

In a duplexed deployment, when a router, logger, peripheral gateway, or CTI OS Server fails over, Agent Greeting behaves as follows:

- Logged in agents are automatically logged out and in again. While this is happening, agents see a brief message in their desktop client status bar showing that they are being disconnected/reconnected.
- After agents are logged back in, their Agent Greeting state (on or off) is set to what it was prior to failover.

#### Failover of VRU PG

In a duplexed deployment, when a VRU peripheral gateway fails over, Agent Greeting play and record may not work until the failover is complete. Agent desktops are unaffected.

#### Failure to Access CVP Media Server

If the connection to the CVP media server fails, or if a requested greeting audio file cannot be found for any reason, the call proceeds normally without the Agent Greeting.

#### Failure to Access CVP VXML Server

If the VXML Server fails during a greeting recording session, the agent experiences a dropped call.

#### Agent Desktop Closes Unexpectedly

If the CTI OS Agent Desktop software closes unexpectedly (for example, due to a crash), when the agent relaunches it: the agent remains logged in and Agent Greeting state is set to Enabled.
Whisper Announcement with Agent Greeting

You can use Agent Greeting along with the Whisper Announcement feature. Here are some things to consider when using them together:

• On the call, the Whisper Announcement always plays first, before the Agent Greeting.

• To shorten your call-handling time, you may want to use shorter Whisper Announcements and Agent Greetings than you might if you were using either feature by itself. A long Whisper Announcement followed by a long Agent Greeting equals a long wait before an agent is actively handling a call.

• If you use a Whisper Announcement, your agents probably handle different types of calls: for example, "English-Gold Member-Activate Card," "English-Gold Member-Report Lost Card," "English-Platinum Member-Account Inquiry." Therefore, you may want to ensure that greetings your agents record are generic enough to cover the range of call types.
Whisper Announcement with Agent Greeting
CHAPTER 3

Deploy Agent Greeting

This chapter describes how to deploy and configure the Agent Greeting feature.

- Agent Greeting deployment tasks, page 13
- Agent Greeting Scripts, page 27

Agent Greeting deployment tasks

**Procedure**

**Step 1** Ensure your system meets the baseline requirements for software, hardware, and configuration described in the System Requirements and Limitations section. See System Requirements and Functional Limitations, on page 1.

**Step 2** Configure one or more servers to act as media servers. Configuration requirements include IIS and FTP. See Prepare a Media Server, on page 15.

**Step 3** In CVP, add media servers, configure FTP connection information, and deploy the media servers. See Add and Configure Media Servers in CVP, on page 18.

**Step 4** Configure Media Server for Agent Greeting, on page 14.

**Step 5** Republish .tcl Scripts to VXML Gateway, on page 18 for Agent Greeting support.

**Step 6** Set Cache Size on VXML Gateway, on page 19.

**Step 7** Record the voice prompts to play to agents when they record a greeting and to deploy the audio files to your media server, see Create Voice Prompts for Recording Greetings, on page 19.

**Step 8** Configure Call Types, on page 20 to record and play agent greetings.

**Step 9** Configure Dialed Numbers, on page 20 to record and play agent greetings.

**Step 10** Define Network VRU Scripts for Agent Greeting, on page 21.

**Step 11** In Script Editor:

- To use the installed scripts to record and play agent greetings, Import example Agent Greeting scripts, on page 22.
To create your own scripts, see Agent Greeting Scripts, on page 27.

Step 12 Modify the CCE Call Routing Scripts to Use Play Agent Greeting Script, on page 25.

What to Do Next
Schedule the script, on page 14.

Schedule the script

Procedure

Step 1 Select Script > Call Type Manager.
Step 2 From the Call Type Manager screen, select the Schedule tab.
Step 3 From the Call type drop-down list, select the call type to associate with the script; for example, PlayAgentGreeting.
Step 4 Click Add and select the script you want from the Scripts box.
Step 5 Click OK twice to exit.

What to Do Next
Add the Active X controls for Agent Greeting to your custom C++ or COM-sourced CTI OS agent and supervisor desktops. See Include Agent Greeting Controls in Agent Desktops, on page 27

Configure Media Server for Agent Greeting

Agent Greeting uses the Unified CVP media server. If you previously configured and deployed one or more Unified CVP media servers for other features, you do not have to configure any additional servers for Agent Greeting. You can optionally add additional media servers.

Agent Greeting uses the Unified CVP media server to store and serve the following types of files:

- Prompt files, prepared by Administrators. These files supply the prompts that agents hear when they record their greetings. The Administrator must manually add the prompt files to all of the media servers that their Agent Greeting scripts will query to retrieve those files.

- Greeting files, recorded by agents. These files are the actual greetings that play to callers. They are recorded by individual agents. The system handles the storage of these files as follows:
  - A greeting file is named using the convention AgentGreetingType_agentID. For more about AgentGreetingType, see Specify AgentGreetingType Call Variable, on page 25.
  - When a greeting is first recorded, it is stored temporarily on the Unified CVP Call Server, where an agent can listen to it prior to confirming its use.
  - When the agent confirms the greeting, the file is transferred, using FTP, to all media servers that are deployed and are configured with FTP enabled. Make sure an FTP server is installed and
configured for the correct version of IIS on the media server. For instructions consult the Microsoft corporation (http://microsoft.com).

To satisfy a request for the greeting to play to a caller, the greeting file is copied from the media server to the VXML Gateway, where it is cached. The cached copy is used to satisfy subsequent requests for the greeting. Content expires in the cache based on the cache timeout period defined on the media server.

The routing scripts look for the prompt and greeting files either on the configured default Unified CVP media server or on a specific server identified in the script. Some typical scripting scenarios for retrieving files for Agent Greeting include:

- All files are retrieved from the default server.
- All files are retrieved from the default server if available; otherwise, a redundant server is queried.
- For security, the prompt files are retrieved from one server and the greetings files are retrieved from a different server.
- For load balancing, the greetings files are dispersed among several servers and retrieved based on tests in the script.

To configure a Unified CVP media server or add a new one to the list, see CVP Media Server.

**Media server hardware and network requirements**

1. Ensure the server is accessible to CVP, Unified CCE, and your agent desktops.
2. See the Unified CVP Hardware and System Software Functional Specification for information about Media Server hardware requirements and co-resident software compatibilities.

**Prepare a Media Server**

1. Ensure that IIS is properly configured and running on the server. It must be listening on port 80.
2. Ensure the server is accessible to CVP, Unified CCE, and your agent desktops.
3. Perform the following steps:
   a. On the taskbar, click Start, point to Administrative Tools, and then click Server Manager.
   b. In the Server Manager hierarchy pane, expand Roles, and then click Web Server (IIS).
   c. In the Web Server (IIS) pane, scroll to the Role Services section, and then click Add Role Services.
   d. On the Select Role Services page of the Add Role Services wizard, expand FTP Server.
   e. Select FTP Service.
   f. Click Next.

To support ASP.NET membership or IIS Manager authentication for the FTP service, you need to select FTP Extensibility.
g On the **Confirm Installation Selections** page, click **Install**.

h On the **Results** page, click **Close**.

i In the sites section, click **Add FTP Site**. Provide a site name and path to the same location as the http directory c:\inetpub\wwwroot.

j Select your desired binding method, specify to start automatically, select **No SSL** and click **Next**.

k On the **Authentication and Authorization** section select the type of authentication required. If using basic, note the name and password of the account.

l Select the authorization; for anonymous select **Anonymous users**.

m Set the read and write permissions.

---

**Note** Make note of your FTP connection information -- connection type, user name, password, and port number.

---

4 Make sure that the FTP and the IIS share the same root directory, because the recording application writes the file to the media server directory structure, and the greeting playback call uses IIS to fetch the file. The en-us/app directory should be under the same root directory for FTP and IIS.

5 Create a dedicated directory on the server to store your greeting files. This lets you specify a lower cache timeout of 5 minutes for your agent greeting files that does not affect other more static files you may be serving from other directories. By default, the Record Greeting application posts the .wav file to the en-us/app directory under your web/ftp root directory. You may create a dedicated directory such as ag_gr under the en-us/app directory, and then indicate this in the Unified CCE script that invokes the recording application. Use the array for the ECC variable call.user.microapp.ToExtVXML to send the ftpPath parameter to the recording application. Make sure the ECC variable length is long enough, or it may get truncated and fail.

6 In IIS Manager, set the cache expiration for the dedicated directory to a value that allows re-recorded greetings to replace their predecessor in a reasonable amount of time, while minimizing requests for data to the media server from the VXML Gateway. The ideal value varies depending on the number of agents you support and how often they re-record their greetings. Two minutes may be a reasonable starting point.

7 Also find the site you are using, go to the agent greeting folder you created (ag_gr), and then select **HTTP Response Headers**.

8 Select **Add**, then **Set Common Headers**.

9 Select **Expire Web Content** and set your desired value.
Afterspecifyingthecachetimeout,itisagoodideatoclearthecacheontheVXMLGateway.Thisisensures
thegatewayrequeststheselatestfilesfromthemedia server. Youneedonlyclearthegatewaycacheonce.
OpenacommmandpromptontheCVPVXMLGateway,logintoIOS,andeenterthefollowingcommands:

```
my_server# conf t
my_server(config)# clear http client cache
my_server(config)# exit
my_server(config)# wr
```

---

**Note**
TheHTTPclientresponsetimeoutsettingonthegatewaymustbegreaterthanthetimeittakesto complete
the largest anticipated FTP file transfer. If an FTP file transfer takes longer than the configured duration
in seconds for HTTP client timeout, the FTP Transfer completes correctly, but the call drops as
soon as the configured timeout duration is met. To change the HTTP client response timeout setting, open
a command prompt on the CVP VXML Gateway, log into IOS, and enter the following commands:

```
my_server# conf t
my_server(config)# http client response timeout <new value in seconds>
my_server(config)# exit
my_server(config)# wr
```

By default, the HTTP client response timeout value for CVP is 30 seconds.

---

**How greeting files are recorded and served**

Followingis an illustration of how Greeting files are recorded and served, followed by a step by step description.
An agent initiates a greeting recording session and records a greeting.

The VXML Gateway passes the recorded (but unsaved) greeting file to the VXML Server.

The agent asks to listen to the greeting before saving it. The file is played from the VXML Server.

The agent saves the greeting. The file is named (based on the agent Login Name + AgentGreetingType) and stored on the media server.

Requests for the greeting file come in through the VXML Gateway. The VXML Gateway examines its web server cache for the file. If the file is present and not expired, the cached version is served. If the file is not present, or if its timestamp exceeds the cache expiration, the file is retrieved from the media server and cached again.

Add and Configure Media Servers in CVP

You can add one or more servers to CVP to act as media servers. If you add multiple media servers, note the following:

- CVP automatically propagates files that are added to one media server out to all media servers in the list that have FTP enabled. To enable FTP on a media server, use the following procedure.

- You can designate one media server as the default. If a default media server is defined, requests for files are automatically sent to that server without your having to specify that server in your routing scripts.


At the CVP Operations Console, select Device Management > Media Server.

Add a server to the list of CVP media servers.

Select FTP Enabled.

Configure the credentials and port settings that will permit CVP to write files to the server using FTP.

Optionally, you can designate one of your media servers as the Default Media Server.

Click the Deploy button to deploy the list of media servers to your CVP Call Servers.

Note: If you deploy the list of media servers and then designate a default, you must redeploy the list.

Republish .tcl Scripts to VXML Gateway

The .tcl script files that ship with Unified CVP Release 9.0(1) include updates to support Agent Greeting. You must republish these updated files to your VXML Gateway.

Republishing scripts to the VXML Gateways is a standard task in CVP upgrades. If you did not upgrade CVP and republish the scripts, you must republish the scripts before you can use Agent Greeting.
**Procedure**

**Step 1** In the Unified CVP Management Console, select **Bulk Administration > File Transfer > Scripts and Media**.

**Step 2** Set Device to Gateway.

**Step 3** Select the gateways you want to update. Typically you would select all of them unless you have a specific reason not to.

**Step 4** Select Default Gateway Files.

**Step 5** Click **Transfer**.

---

**Set Cache Size on VXML Gateway**

To ensure adequate performance, set the size of the cache on the VXML Gateway to the maximum allowed. The maximum size is 100 megabytes; the default is 15 kilobytes. Failure to set the VXML Gateway cache to its maximum can result in slowed performance to increased traffic to the media server.

Use the following Cisco IOS commands on the VXML Gateway to reset the cache size:

```conf
cfg t
http client cache memory pool 100000
exit
wr
```

For more information about configuring the cache size, see the *Configuration and Administration Guide for Cisco Unified Customer Voice Portal*.

---

**Create Voice Prompts for Recording Greetings**

You must create audio files for each of the voice prompts that agents hear as they record a greeting. The number of prompts you require can vary, but a typical set can consist of:

- A welcome followed by a prompt to select which greeting to work with (this assumes you support multiple greetings per agent)
- A prompt to select whether they want to hear the current version, record a new one, or return to the main menu
- A prompt to play if a selected greeting is not found.

To create voice prompts for recording greetings:

**Procedure**

**Step 1** Create the files using the recording tool of your choice. When you record your files:

- The media files must be in .wav format. Your .wav files must match Unified CVP encoding and format requirements (G.711, CCITT A-Law 8 kHz, 8 bit, mono).
- Test your audio files. Ensure that they are not clipped and that they are consistent in volume and tone.
Step 2  After recording, deploy the files to your Unified CVP media server. The recommended default deployment location is to the `<web_server_root>\en-us\app` directory.

Step 3  Note the names of the files and the location where you deployed them on the media server. Your script authors need this information for the Agent Greeting scripts.

### Built-in Recording Prompts

The Unified CVP Get Speech micro-application used to record Agent Greetings includes the following built-in prompts:

- A prompt that agents can use to play back what they recorded
- A prompt to save the greeting, record it again, or return to the main menu
- A prompt that confirms the save, with an option to hang up or return to the main menu

You can replace these `.wav` files with files of your own. For more information, see the CVP Call Studio documentation.

### Example Record Greeting Prompts

Unified CCE includes three example record greeting audio prompts. These are installed on each ICM server at `<icm_root>\wav`. These example files are referenced in the example recording script that are included with ICM. If you plan to deploy the example script, copy the audio prompts to the `<web_server_root>\en-us\app` directory on your media server.

### Configure Call Types

To record and play agent greetings, create the following call types.

**Procedure**

- **Step 1**  In Unified CCE Administration, select Manage > Call Type.
- **Step 2**  Create a call type to record agent greetings and use the name RecordAgentGreeting.
- **Step 3**  Create a call type to record agent greetings and use the name PlayAgentGreeting.

### Configure Dialed Numbers

To record and play agent greetings, create the following dialed numbers.
Procedure

Step 1  In CCE Administration, select Manage > Dialed Number.
Step 2  Create a dialed number to record agent greetings and use the name RecordAgentGreeting. The name must match exactly and is case-sensitive.
Step 3  Create a dialed number to record agent greetings and use the name PlayAgentGreeting. The name must match exactly and is case-sensitive.
Step 4  Complete the following for each dialed number:
   a) For routing type, use Internal Voice.
   b) Leave domain as is. The domain defaults to a set value and you cannot change it.
   c) To associate each number to its call type (and to a script that will execute), select the call type that matches the purpose of each dialed number.

Define Network VRU Scripts for Agent Greeting

For Agent Greeting record and play scripts to interact with Unified CVP, Network VRU scripts are required. The number of VRU scripts that you require and how you configure them depends on how you choose to script Agent Greeting.

To create these scripts, use the Network VRU Script List Tool found in Configuration Manager

The following table lists an example set of Agent Greeting Network VRU scripts based on the example Agent Greeting scripts that are included with the software.

Note
If you require the following example VRU scripts, you must manually create them.

- The Network VRU must be a Type10
- The default timeout 180 is acceptable
- Leave Overridable unchecked

Table 1: Agent Greeting Network VRU Scripts

<table>
<thead>
<tr>
<th>Name / VRU Script Name</th>
<th>Configuration Parameter</th>
<th>Interruptible (Y/N)</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>AgentGreeting</td>
<td>null</td>
<td>N</td>
<td>Causes a saved greeting audio file to play. The -a parameter automatically generates the file name by concatenating the agent's Login Name with the AgentGreetingType variable value set in your routing scripts that target an agent.</td>
</tr>
<tr>
<td>FM, -a</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name / VRU Script Name</td>
<td>Configuration Parameter</td>
<td>Interruptible (Y/N)</td>
<td>What it does</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------</td>
<td>---------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>GreetingMenu_1_to_9</td>
<td>1-9</td>
<td>Y</td>
<td>During a recording session, play an audio file that presents a voice menu prompting the agent to press the number corresponding to the greeting he or she wants to record. The 1-9 configuration parameter defines the range of allowable keys. So this value also determines the number of concurrent greetings agents can have. The A parameter specifies that the file is in the (default) Application directory on the Unified CVP VXML Server.</td>
</tr>
<tr>
<td>GreetingSubMenu</td>
<td>1-3</td>
<td>Y</td>
<td>During a recording session, play an audio file that prompts the agent to press 1 to listen to a greeting, 2 to record, or 3 to go to the main menu.</td>
</tr>
<tr>
<td>Greeting_Not_Found</td>
<td>Y</td>
<td>Y</td>
<td>During a recording session, if an agent tries to play back a greeting that does not exist, play the no_greeting_recorded audio file. The Y configuration parameter in this instance allows barge-in (digit entry to interrupt media playback).</td>
</tr>
<tr>
<td>T10_GS_AUDIUM</td>
<td>,,,,,,,,,,Y</td>
<td>Y</td>
<td>This starts the external VXML application that records the greeting. The VRU script name must be specified exactly as shown and is case-sensitive. The Y parameter in the eleventh position of the Configuration Parameter is required. It allows the script to pass FTP connection information to the VXML server. The VXML server then uses this information to make an FTP connection to the media server when saving greeting files.</td>
</tr>
</tbody>
</table>

**Note**

For descriptions of VRU Script Name parameters and detailed instructions on creating Network VRU scripts for CVP micro-applications, see the Configuration and Administration Guide for Cisco Unified Customer Voice Portal.

**Import example Agent Greeting scripts**

To view or use the example Agent Greeting scripts, you must first import them into Script Editor. To import the scripts:
Procedure

Step 1
Launch Script Editor.

Step 2
Select File > Import Script and select a script to import.
The scripts are located in the icm\bin directory on the data server (DS) node.

Note
When you import the example scripts, Script Editor maps objects that are referenced in the scripts.
Some of the objects, such as the external Network VRU scripts, skill groups, route to SkillGroup, or
Precision Queue, do not map successfully. You must create these manually or change these references
to point to existing scripts, skill groups, and Precision Queues in your system.

What to Do Next
In addition to importing the scripts, you may need to modify the following items. For more information, see
Agent Greeting Scripts, on page 27.

- If you do not use a default media server, you must modify the media server specification.
- If you do not use the default values for application and locale (en-us/app), you must modify the path
  name of greeting files.
- Using the Unified CCE Administrator tool, enable all expanded call variables referenced by the following
  sample scripts.

Agent Greeting Example Routing Scripts

The example routing script files in the icm\bin directory include:

- **AG.ICMS**—This script sets up an Agent Greeting by setting the greeting type to be used on the call
  and then queueing the call to a skill group or Precision Queue. Once an agent is selected from the skill
  group or Precision Queue and the call routed to the agent, the PAG.ICMS script is invoked. It requires
  that you define an AgentGreeting VRU script (described in Define Network VRU Scripts for Agent
  Greeting, on page 21) and a skill group.

- **PAG.ICMS**—This script causes an Agent Greeting to play. It is invoked by the PlayAgentGreeting
dialed number that you configured earlier in the configuration process. This number must be associated
with a call type that then executes the script. It requires that you define an AgentGreeting VRU script,
described in Define Network VRU Scripts for Agent Greeting, on page 21.

- **RECORD_AG.ICMS**—This script lets agents record a greeting. It is called from the agent desktop
  when an agent clicks the Record Agent Greeting button. It prompts the agent to select which greeting
  to play or record. This script is invoked by the RecordAgentGreeting dialed number that you configured
  earlier in this configuration process. It requires that you define all five VRU scripts described in Define
  Network VRU Scripts for Agent Greeting, on page 21.

- **WA_AG.ICMS**—This script plays a Whisper Announcement and an Agent Greeting together on the
  same call flow. It requires that you define an AgentGreeting VRU script (described in Define Network
  VRU Scripts for Agent Greeting, on page 21) and a skill group.
The PAG.ICMS and RECORD_AG.ICMS example scripts assume that a default media server is configured in Unified CVP, and the greeting files are stored in a dedicated directory named ag_gr directory. The WA_AG.ICMS script does not include a dedicated directory.

For greeting, the initial script sets up the call between caller and agent, and a different script plays the greeting to the agent after the caller is connected. If the initial Unified CCE script overrides the default media server with a SET node, the call context of expanded call variables is preserved on the greeting playback call as well, and the Default Media Server may be overridden. In this case, modify the greeting playback script to use a SET node with the correct media server.

### Test Agent Greeting File Path

When an agent records a greeting, the greeting file is saved with a system-generated name as follows:

- The file name starts with the value of the Call.AgentGreetingType variable associated with the choice the agent made when recording the greeting. For example, if the agent selected the first option, and the Agent Greeting record script sets the first option to "1," then the greeting file name is appended with _1. As another example, if descriptive strings were implemented, and the first option is associated with the string "French," then the greeting file name starts with French_.

- The agent's id number is appended to the starting string. For agent 10201 would have greeting files named 10201_1 or 10201_French.

The greeting file is saved in a directory whose path is determined by the following variables in the Agent Greeting record script:

- A specific media server, or the default media server. (The file is later pushed to all FTP-enabled media servers.)

- A specific application directory, or the default application directory.

- A specific locale directory, or the default locale directory.

To test the path you defined to the greeting file in your script variables, plug the complete URL into a browser. The .wav file should play. For example:

- If your script uses a default media server whose IP is 192.1.1.28 + the default locale + an application directory named greet + agent123_im1.wav, then the generated URL should be http://192.1.1.28/en-us/app/greet/agent123_1.wav. Entering this URL into a browser should cause this agent’s greeting to play.

- If your script includes: http://my_server.my_domain.com + the default locale + an application directory app/greet + agent123_1.wav, then the path should be http://my_server.my_domain.com/en-us/app/greet/agent123_1.wav.
Modify the CCE Call Routing Scripts to Use Play Agent Greeting Script

For an Agent Greeting play script to run, you must add an AgentGreetingType Set Variable node to your existing CCE call routing scripts: This variable's value is used to select the audio file to play for the greeting. Set the variable before the script node that queues the call to an agent (that is, the Queue [to Skill Group or Precision Queue], Queue Agent, Route Select, or Select node). For more information, see Agent Greeting Example Routing Scripts, on page 23.

Specify AgentGreetingType Call Variable

To include Agent Greeting in a script, insert a Set Variable node that references the AgentGreetingType call variable. The AgentGreetingType variable causes a greeting to play and specifies the audio file it should use. The variable value corresponds to the name of the greeting type for the skill group or Precision Queue. For example, if there is a skill group or Precision Queue for Sales agents and if the greeting type for Sales is '5', then the variable value should be 5.

You can use a single greeting prompt throughout a single call type. As a result, use one AgentGreetingType set node per script. However, as needed, you can set the variable at multiple places in your scripts to allow different greetings to play for different endpoints. For example, if you do skills-based routing, you can specify the variable at each decision point used to select a particular skill group or Precision Queue.

Note

Only one greeting can play per call. If a script references and sets the AgentGreetingType variable more than once in any single path through a script, the last value to be set is the one that plays.

Use these settings in the Set Variable node for Agent Greeting:

- Object Type: Call.
- Variable: Must use the AgentGreetingType variable.
- Value: Specify the value that corresponds to the greeting type you want to play. For example: "2" or "French"
  - You must enclose the value in quotes.
  - The value is not case-sensitive.
  - The value cannot include spaces or characters that require URL encoding.
The following script example illustrates how to include Agent Greeting in a script using the Set Variable node:

**Figure 2: Modified call routing script to enable greeting play**

Scripting Agent Greeting for multiple customers

In the out-of-box method for deploying Agent Greeting, Unified CCE uses the customer information from the built-in "PlayAgentGreeting" dialed number to choose the correct network VRU to play the greeting. If your deployment has multiple customers configured within your Unified CCE instance and you want to use Agent Greeting with all of them, you must configure things differently to work around customer associations.

Configure custom dialed number for Agent Greeting play

To play Agent Greetings for multiple customer instances, configure the built-in PlayAgentGreeting dialed number for each Unified CM routing client, but do not associate it with a specific customer. The Unified CM peripheral uses this number to initiate Agent Greeting play. If you want your greetings to be played from a different network VRU, use the TranslationRouteToVRU node in your routing scripts to explicitly choose the network VRU.

Configure custom dialed number for Agent Greeting record

To record Agent Greetings when you have multiple customers, you must create your own custom dialed number for recording. You may want to create different dialed numbers for different customers. As with Agent Greeting play, if you want to use different network VRUs to record Agent Greetings for different customers, use the TranslationRouteToVRU node in your routing script to explicitly select the network VRU.

When you create your own dialed number to record greetings, you cannot use the default Record Greeting button that ships with CTI OS (as it is associated with the hard-coded "RecordAgentGreeting" DN). Create your own custom button or have your agents enter the record dialed number using the dial pad on their desktops.
Include Agent Greeting Controls in Agent Desktops

CTI OS includes Active X objects that let you include Agent Greeting controls in your COM and C++ sourced agent desktops. Available controls include Enable Greeting, Disable Greeting, and Record Greeting. See your CTI OS Developer's Guide for more information. Agent Greeting controls are not supported with Java or .NET based CTI OS desktops, or with non-CTI OS desktops such as CAD.

Agent Greeting Scripts

Agent Greeting requires two call routing scripts: one that agents can use to record greetings and one to play a greeting to callers. Examples of these scripts are included in your installation. This section describes the elements in the installed example scripts, including optional features and other modifications that you can make. To create scripts from scratch, use this section to understand the required elements in Agent Greeting scripts.

If you plan to use the installed example scripts out of the box, you can ignore this section.

Agent Greeting Recording Script

The Agent Greeting recording script is a dedicated routing script that allows agents to record greetings. You can use the installed example scripts or create your own.

The script should be called from the agent desktop when an agent clicks the Record Greeting button. If you support multiple greetings per agent, it should include prompts to select which greeting to play or record. The dialed number RecordAgentGreeting must be created for the specific routing client and associated with a call type which then executes this script.

In the example script shown here, the agent is first prompted to select one of nine possible greeting types. After selecting a greeting type, the agent chooses whether to 1) listen to the existing greeting for that type; 2) record a new greeting for that type, or 3) return to the main menu. If the agent selects the option to listen, the name of the application directory on the media server is set and the external VRU script that plays the greeting is triggered. Then the agent is returned to the main menu. If the agent selects the option to record, the Unified CVP recording application is called. The recording application contains its own built-in audio prompts that step the agent through the process of recording and saving a greeting. At the end, the agent is returned to the main menu.

There are several other behaviors in the script to note: An agent may select to listen to a greeting type for which no greeting exists. In that event, a VRU script that plays an error message is called. Also, in two places in the script, the path to the application directory is reset to the default. This is because (in this example) that
is where the files for the audio files reside. The only files that reside outside of the default directory are the greetings themselves.

Figure 3: Agent Greeting record script

RecordAgentGreeting Micro-Application

Unified CVP includes a dedicated micro-application -- RecordAgentGreeting -- for recording agent greetings. The application lets agents record, review, re-record, and confirm the save of a greeting. It includes audio files to support each of these functions. If an agent is not satisfied with a greeting, it can be re-recorded up to three times. Upon confirmation of a save, the application FTPs the saved file to the media server. Built-in error checking includes checks for the data required to name the file (agent Login Name + AgentGreetingType variable value), media server specification, valid menu selections made by the agent, and successful FTP of the greeting file.

Agent Greeting Record Script Nodes

Using the example script as a reference, here are descriptions of the functions its nodes perform.

Table 2: Script Node Functions for Agent Greeting

<table>
<thead>
<tr>
<th>Node</th>
<th>Value</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable:Call:user. microapp.input_type</td>
<td>D</td>
<td>Sets the allowable input type to DTMF (touch tone).</td>
</tr>
<tr>
<td>RunExtScript:Press 1-9 to Select Greeting X</td>
<td>M,press_1_thru_9_greeting,A</td>
<td>Runs the VRU script that defines which digits are valid to select an AgentGreetingType and plays a voice prompt describing the options.</td>
</tr>
</tbody>
</table>
### What it does

<table>
<thead>
<tr>
<th>Node</th>
<th>Value</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable:Call:AgentGreetingType</td>
<td>Call.CallerEnteredDigits</td>
<td>Sets the AgentGreetingType to the digit the agent pressed. This text is used in the greeting wave file. It can be a simple numbering system or more descriptive titles such as &quot;English.&quot;</td>
</tr>
<tr>
<td>RunExtScript: M,press1-press2-press3,A</td>
<td></td>
<td>Runs the VRU script that defines which digits are valid to select a desired action and plays a voice prompt describing the options.</td>
</tr>
<tr>
<td>CED</td>
<td>1,2,3</td>
<td>Tells the script how to handle the caller entered digits in response to the 1,2,3 external script.</td>
</tr>
<tr>
<td>Variable:Call: user.microapp.app_media_lib</td>
<td>Set three times:</td>
<td>Defines the path to the application directory on the Unified CVP media server. Prior to playing the greeting file, it is set to the dedicated greeting file directory (in this example, app/ag_gr). After the greeting file plays, it is reset to the default application directory where (in this example) the files for voice prompts are stored. If the voice prompts were stored in the same directory as the greeting files, there would be no need to reset the path.</td>
</tr>
<tr>
<td>RunExtScript: Play Recording</td>
<td>PM,-a,A</td>
<td>Runs the VRU script that plays the selected Agent Greeting.</td>
</tr>
<tr>
<td>RunExtScript: Greeting Not Found</td>
<td>PM,no_greeting_recorded,A</td>
<td>Runs the VRU script that plays an error message if the Agent Greeting selected to play does not exist.</td>
</tr>
</tbody>
</table>
### What it does

**ValueNode**

Specifies the FTP information that the VXML server uses to write greeting files to the media server. The information must match the FTP information configured for the media server in the Unified CVP Operations Console.

The value for array index must be 2.

The value consists of:

- `ftpPath=` to set the path to the dedicated directory for agent greeting files.
- The path must begin with the locale directory.

To view additional setting options, see CVP documentation.

#### ArrayIndex: 2

**Value:** "ftpPath=<path_to_dedicated/directory>"

For example: "ftpPath=en-us/app/ag_gr"

---

### Value

**Variable:**

Call:user.microapp.

ToExtVXML[]

<table>
<thead>
<tr>
<th>Node</th>
<th>Value</th>
<th>What it does</th>
</tr>
</thead>
</table>
| Array Index: 2 | Value: "ftpPath=<path_to_dedicated/directory>" | Specifies the FTP information that the VXML server uses to write greeting files to the media server. The information must match the FTP information configured for the media server in the Unified CVP Operations Console. The value for array index must be 2. The value consists of:  
  - `ftpPath=` to set the path to the dedicated directory for agent greeting files.  
  - The path must begin with the locale directory.  
  
To view additional setting options, see CVP documentation. |

#### ArrayIndex: 0

**Value:** "application=RecordAgentGreeting"

Identifies the external Unified CVP micro-application (RecordAgentGreeting) that is used to record the greeting.

The value for array index must be 0.

#### RunExtScript: Run Default Recording Application

**Value:** GS,Server,V

Runs the VRU script that launches the Get Speech micro-application on the VXML server.

---

### Specify Media Server in Routing Scripts

When you configure media servers in CVP, you can specify a default media server. The benefit to specifying a default media server is that your scripts do not need a Set Variable node to access the default media server. For this to work, you must make sure that the files a script requests are stored on the default server.

If you do not define a default media server, or if you define a default but the files that your script requires are not stored on the default, then the script must include a Set Variable node to identify a media server.

To specify a media server that stores the files required by your script, use the following settings in the Set Variable node:

- **Object Type:** Call.
- **Variable:** Must use the user.microapp.media_server expanded call variable.
- **Value:** Specify the HTTP path to the server. For example: "http://myserver.mydomain.net." You must enclose the path in quotes.
- Alternately you can specify an IP address in place of a DNS. Include the listening port number if the web server for the media server listens on a port other than 80 (for HTTP) or 443 (for HTTPS).
In scripts that invoke an external VXML application (as the Agent Greeting record script does), if you explicitly set a variable for the media server (user.microapp.media_server), then you must also set the following variables:

- The path to the media server application directory (user.microapp.app_media_lib)
- The CVP UseVXMLParams value to N.(user.microapp.UseVXMLParams)

See the following example.

**Figure 4: Additional required variables when specifying a media server**

Specify Greeting File Locale and Application Directories in Routing Scripts

CVP uses a default storage directory for media files: `<web_server_root>/en-us/app`. To take advantage of this, Unified CCE call routing scripts automatically add `en-us/app` to the server name when constructing HTTP requests for media files. For example:

- If the script node that defines the media server has a value of "http://myserver.mydomain.com," and
- The script node that defines which audio file to play has a value of "agent123_1.wav", then
- The HTTP request for the file is automatically constructed as

  http://myserver.mydomain.com/en-us/app/agent123_1.wav

If your greeting audio files are stored in a different locale directory, you must add a Set Variable node to your script that identifies the locale directory. As you must store your greeting files in a dedicated subdirectory under the locale, you must always add a Set Variable node that identifies that directory.

Use these settings in the Set Variable node to specify your locale directory:

- Object Type: Call.
- Variable: Must use the user.microapp.locale expanded call variable.
- Value: Specify the directory name. For example: "pt-br" (Portuguese-Brazil). You must enclose the path in quotes.

Use these settings in the Set Variable node to specify your application directory:

- Object Type: Call.
- Variable: Must use the user.microapp.app_media_lib expanded call variable.
- Value: Specify the directory name. For example: to use a directory “greet” in place of the default directory "app", enter "greet". To use a sub-directory "greet" under "app" enter "app/greet". You must enclose the path in quotes.
Verify Length for Media Server Locale and Application Directory Variables

If you include Set Variable nodes for the media server, locale, and/or application directories, make sure that the values you set for them do not exceed the Maximum Length settings for their corresponding expanded call variables.

For example, if you include a Set Variable node for the media server with a value of "http://mysubdomain.mydomain.co.uk", the string is 33 characters long. Therefore, the Maximum Length setting for the user.microapp.media_server expanded call variable must be 33 or greater. Otherwise, the server name is truncated in the HTTP request for the file and the file is not found.

To configure expanded call variables, use the Unified CCE Configuration Manager. Select List Tools > Expanded Call Variables List.

To configure ECC variables, use Unified CCE Administration. Select Manage > Expanded Call Variables.

Descriptive Agent Greeting Type Strings

The previous Agent Greeting record script example stores Agent Greeting Type values as numbers (although in string format). But suppose you prefer more descriptive string names. For example, "English," "French," and "Spanish." Or "Sales," "Billing," and "Tech Support." Descriptive names can make it easier to understand at a glance what different numeric key selections in your scripts correspond to. Note that they also affect how greeting files are named (for example agent123_English.wav as opposed to agent123_1.wav).

The following script example is almost identical to the previous recordscript, except that it includes four additional nodes (highlighted in green). They consist of an additional CED node that maps the keys 1, 2, and 3 to language names. The Run Ext Script node (in gray) was modified for the new options. The rest of the script is the same with no other changes required. Note that your routing scripts require a corresponding mapping of numeric keys to language names.

Figure 5: Script with descriptive greeting type strings
Agent Greeting Play Script

The Agent Greeting feature requires a dedicated routing script that causes the agent greeting to play. This script is invoked by the PlayAgentGreeting dialed number.

The Play script must contain at least two and possibly four specific nodes, depending on other factors. You always need the following nodes:

- A Run External Script node that calls the VRU script that plays the greeting.
- A Set Variable node that sets the directory path to your greeting files.

You may also need to include in your scripts Set Variable nodes that:

- Specify the Media Server: Unified CVP lets you specify a default media server. If you are not serving your audio files from the default media server, your scripts must include a variable that identifies the server where your audio files are stored.
- Specify the Locale Directory: Additionally, if you are not storing your files in the default locale directory shoulden-us on the media server, you must include a variable that specifies the name of the locale directory where the files are stored.

Note: The Locale Directory set variable node is optional. It is needed only if you decide to use another directory other than the default one.

Figure 6: Agent Greeting Play Script Example
Using Agent Greeting with Your CTI OS Agent or Supervisor Desktop

- Record a Greeting, page 35
- Delete Greeting, page 36
- Review Greetings, page 36
- Enable or Disable Greeting Play, page 36
- Agent Greeting with the Outbound Agent Desktop, page 36
- Agent Greeting During Transfers and Conferences, page 37

Record a Greeting

Recording an Agent Greeting is very similar to recording a personal message for your voice mail. To record a greeting, you must be logged in to your desktop software and in the Not Ready state. To record a greeting:

**Procedure**

**Step 1** Click the Agent Greeting Record button on your desktop.

**Step 2** You may hear a brief ring tone, after which you receive voice instructions for recording a greeting. Options may include selecting a greeting type (if your contact center uses more than one greeting per agent), recording, playing back, and confirming whether to use the new greeting. There is also an option for listening to your existing greetings.

**Step 3** After you connect to the Record Greeting service, a dialog box containing a dial pad appears on your agent desktop. You can use the dial pad or the keypad on your phone to make your selections. (If you close the dialog box before you finish recording your greeting, you cannot re-open it; use the keypad on your hard phone to complete your recording.)

**Step 4** To exit without recording a greeting, release the call.

The number of greetings that you need to record is determined by your contact center. It may vary depending on things like your skill group or Precision Queue membership or the time of day or day of the week.
contact center also determines how long your greeting can be. When you are recording, if you reach the maximum recording time, you receive a notification.

Delete Greeting

You cannot delete an agent greeting. However, you can record over previously recorded greetings. When you record over a greeting, the new greeting is used for the next customer call you take.

Review Greetings

To listen to your current greetings, click the Agent Greeting Record button on your desktop and select a greeting.

Enable or Disable Greeting Play

Your CTI desktop toolbar includes a Greeting button that you can use to turn the Agent Greeting feature on or off. There are various reasons you might want to turn off your greeting. You might want to turn off your greeting on a day when you have a cold and you are concerned that your voice does not sound like your recorded message. Or you might want to turn off a greeting that was appropriate yesterday but is not today, until you have time to go Not Ready and record a new one. Turning off Agent Greeting does not affect a greeting that is already playing to a caller.

Turning off Agent Greeting stops your greetings from playing until you manually turn it back on again, or until the next time you log in to the desktop; Agent Greeting is always automatically turned on at login.

To turn Agent Greeting off, with Greeting enabled, click the **Greeting** button.

To turn Agent Greeting back on, click the **Greeting** button again.

Agent Greeting with the Outbound Agent Desktop

Agent greetings play to inbound callers only; they do not play when you make an outbound call. If you are an outbound-only agent, you can still record greetings but they do not play, even when Agent Greeting play is turned on in your desktop toolbar.
Agent Greeting During Transfers and Conferences

When you blind transfer a call to another agent, your customer hears the other agent's greeting (assuming that agent has greeting enabled). Similarly, when you conference in another agent, all parties on the call hear the other agent's greeting.

Consultative transfers work a little differently. When you place a consultative transfer, your customer does not normally hear the other agent's greeting, unless you transfer the customer while the other agent's greeting is still playing.

Agent desktop closes

If, while you are logged in, your CTI OS Agent Desktop software closes for any reason, when you relaunch it your Agent Greeting state is set to Enabled.
Agent desktop closes
Using Agent Greeting with your CAD agent or supervisor desktop

This chapter describes how to use Agent Greeting from the CAD Agent or Supervisor desktop.

- Record greeting, page 39
- Add customized task button in the CAD agent for recording an Agent Greeting, page 39

Record greeting

There is no button support for Agent Greeting in CAD desktops. To record a greeting:

1. On your desktop, open the Make a Call dialog.
2. In Name: Number, type or paste "RecordAgentGreeting" (case-sensitive).
3. Check the Dial Number As Entered box.
4. Click Dial.
5. Once the recording session starts, use the Dial Pad on your desktop or the keys on your hard phone to respond to prompts.

Add customized task button in the CAD agent for recording an Agent Greeting

You can add a customized button to record an Agent Greeting. This simplifies the Agent Greeting recording, reducing keystrokes for each agent.

1. Open the CAD Agent.
2. Open the CAD Work Flow Administrator.
3. Navigate to the CAD Agent - User Interface.
4. Choose an available Task.
5 Check the **Visible** box.
6 In the Hint box, enter Record Agent Greeting.
7 Click the **Add** button.
8 Choose the Run Macro tab.
9 Click the **New** button.
10 Enter RecordAgentGreeting.
11 Click the **OK** button.
12 Click the **Record** button.
13 Follow the directions above for Recording a Greeting.
14 When finished, restore the Record dialog from the taskbar and click the **Stop** button.
15 Modify the script as follows:

[Image: RecordAgentGreeting.png]

16 Click the **OK** button.
17 Click the **Add Action** button.
18 Close the CAD Work Flow Administrator and save all changes.
19 Restart the CAD Agent.

The customized Agent Greeting recording button appears on the CAD Agent desktop when the agent desktop is restarted.

**Disable Agent Greeting**

There may be times when you do not want your greeting to play to callers, but as a CAD agent you cannot turn off the Agent Greeting feature—if this feature is enabled for your call center, it is always on. As an
alternative to disabling Agent Greeting, you can record a brief (one second) message consisting of silence. This should mimic no greeting as far as the caller experience is concerned.
Disable Agent Greeting
Agent Greeting in a parent-child deployment

Agent Greeting in Parent/Child configurations must be approved by the Cisco Assessment to Quality (A2Q) process and require Cisco Design Mentoring Service to assure that the deployment model is designed and sized correctly to support the Agent Greeting feature.

After the call is delivered to the child system, the child router picks the target agent, the agent answers the call, and then CVP plays an agent greeting to both the caller and the agent. This feature is supported for both local agents and mobile agents.

On the child Unified CCE, you must:

1. Use IP-IVR on the child for call treatment, queuing and Whisper Announcement (if Whisper Announcement is enabled).
2. Use CVP on the child for Agent Greeting only; not for call queuing. You must use a separate VRU PG for the CVP. Translation route is used to send the greeting call to CVP.

- Configuration tasks, page 43
- Configure routing scripts, page 44

Configuration tasks

You must complete the following tasks on the child to translation route the call to the CVP.

1. Define a VRU PG for CVP.
2. Define a Type10 Network VRU for CVP.
3. Associate the Network VRU to the VRU PG. In the Network VRU configuration, configure the CVP Voice Gateway label for the CVP routing client so that the CVP Call Server can send the call to the gateway to play greetings.
4. Associate Network VRU scripts with the VRU PG.
5. Configure ECC variables for CVP.
6 Associate the Network Trunk Group with the VRU PG. By default, CVP uses trunk group #100 for incoming calls and 200 for outgoing calls. In ICM Network Trunk Group configuration tool, set the Peripheral Number to 200 for the CVP trunk group.

7 Associate the VRU Service with the VRU Peripheral.

8 Associate the Translation Route with the VRU service. Configure translation route labels for the system PG routing client so that the UCM can send the call to CVP.

9 Configure UCM to send the calls to CVP with the translation route labels.

10 Configure CVP DNIS for the translation route labels.

11 Configure the routing scripts.

Configure routing scripts

You must configure the following routing scripts:

- AG.ICMS
- PAG.ICMS
- record_ag.ICMS

You can find sample scripts in the \icm\bin folder.

Configure AG.ICMS routing script

1 In the existing routing script, before sending the call to agents, add a Set node.

2 Set the AgentGreetingType call.

3 In the Call.AgentGreetingType variable, configure the agent greeting type.

Configure PAG.ICMS routing script

To translation route the greeting request to CVP and play agent greeting, configure the PAG.ICMS routing script. The following illustration is an example of how to modify the sample PAG.ICMS script.
Configure RECORD_AG.ICMS routing script

To translation route the recording request to CVP and record an agent greeting, configure the record_ag.ICMS routing script. The following illustration is an example of how to modify the sample record_ag.ICMS script.
Agent Greeting in a parent-child deployment

Configure RECORD_AG.ICMS routing script
Troubleshooting Agent Greeting

This chapter describes how to troubleshoot the Agent Greeting feature.

- Debugging Agent Greeting scripts, page 47
- Monitoring Agent Greeting, page 47
- Frequently asked questions, page 47

Debugging Agent Greeting scripts

The Script Editor Call Tracer utility, which tests and debugs routing scripts to confirm the selection of Unified CCE targets, includes these fields for debugging Agent Greeting scripts:

- Agent (the Enterprise Agent ID),
- Greeting (the greeting type), and
- Customer (the instance)

Monitoring Agent Greeting

As a general monitoring/troubleshooting practice for Agent Greeting, you may find it best to review log files on your Peripheral Gateway in this order:

1. Review the Windows Event Viewer Application log first. It is easier and faster to locate errors here.
2. If you find an error in Windows Event Viewer, note the time. Then use the ICM Dumplog utility to export the contents of your ICM logs to a human-readable file that you can consult for more detail. Dumplog outputs files to `<icm_root>\<instance>\<pg_name>\logfiles\`

Frequently asked questions

Q. What is the maximum number of greetings an agent can have?
A. Unified CCE does not impose a limit on how many greetings your agents can have. You determine the limit in the way you design your scripts. The number of numeric keys on a dial pad imposes a practical limit of nine; however, you can circumvent this by including nested CED nodes in your routing scripts that allow agents to drill-down to the greeting type they want to record.

Q. Can I deploy different Agent Greeting scripts for different types of agents? I work at a large company that has both internal and external tech support agents. The types of greetings these two groups need are not the same.

A. Yes. The best way to do this depends on how your agents are created in the system. For example, if your internal and external agents are created on separate routing clients, you can simply create different Agent Greeting scripts for each of the two routing clients. If internal and external agent records are mixed together on a single routing client, you need a different approach. You can create a script that uses agent Login IDs to direct them to the correct Agent Greeting record script. Or one that requires agents to select their agent type from a menu and then uses that information to select the right Agent Greeting script.

Q. How do I disable Agent Greeting?

A. Individual CTI OS agents can disable Agent Greeting through their desktops. To disable Agent Greeting for groups, remove the call to the Agent Greeting play script from your call routing scripts.
Whisper Announcement capabilities

Whisper Announcement plays a brief, prerecorded message to an agent just before the agent connects with each caller. The announcement plays only to the agent; the caller hears ringing (based on existing ring tone patterns) while the announcement plays.

The content of the announcement can contain information about the caller that helps prepare the agent to handle the call. The information can include caller language preference, choices the caller made from a menu (Sales, Service), customer status (Platinum, Gold, Regular), and so on.

After Whisper Announcement is enabled, the played announcements are specified in the call routing scripts. The determination of which announcement to play is controlled in the script and is based on various inputs, such as the dialed number, a customer ID look up in your customer database, or selections you made from a VRU menu.

- System requirements and functional limitations, page 49

System requirements and functional limitations

To use Whisper Announcement, your system must meet these baseline requirements.

Software requirements

These software pieces must be in place to deploy Whisper Announcement.

<table>
<thead>
<tr>
<th>What</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software versions</td>
<td>To use Whisper Announcement, your Unified CCE deployment must be running:</td>
</tr>
<tr>
<td></td>
<td>• Unified CCE, Release 8.5(1) or later (Mobile Agent requires Unified CCE, Release 8.5(2) or later)</td>
</tr>
<tr>
<td></td>
<td>• Unified CVP, Release 8.5(1) or later</td>
</tr>
<tr>
<td></td>
<td>• Unified CTIOS, Release 8.5(1) or later</td>
</tr>
<tr>
<td></td>
<td>• Unified CM, Release 8.5(1) SU2 or later</td>
</tr>
<tr>
<td></td>
<td>• Unified CCX (IP IVR), Release 8.5(1) SU1 + ciscouccx.851SU1agentwhisper.cop.sgn</td>
</tr>
</tbody>
</table>
Hardware requirements

These hardware pieces must be in place to deploy Whisper Announcement:

<table>
<thead>
<tr>
<th>What</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phones</td>
<td>Whisper Announcement works with Unified CM supported IP phones. See the Unified CCE Compatibility Matrix for the list of supported phones.</td>
</tr>
<tr>
<td>CVP call control protocols</td>
<td>Whisper Announcement is supported with SIP as the CVP call control protocol. H.323 is not supported.</td>
</tr>
</tbody>
</table>

Configuration requirements

To deploy Whisper Announcement, the following configuration pieces must be in place.

<table>
<thead>
<tr>
<th>What</th>
<th>Requirement</th>
</tr>
</thead>
</table>
Whisper Announcement is supported with Type 10 Network VRUs only. (Type 10 is required to allow CVP to control the call). If your current Unified CCE deployment is not configured for a Type 10 VRU, you must modify it accordingly.

Whisper Announcement does not require Extended Call Context (ECC) variables provided that you:

- Retrieve your files from the CVP default media Whisper Announcement Sample Scripts
- Store your files in the media server default locale and application directories (“<web_server_root>/en-us/app”).

However, if you store your files in a location other than these defaults, you must use one or more of the following ECC variables in your scripts. To make these variables available, verify that they are defined in the Unified CCE Configuration Manager tool.

- **user.microapp.media_server**: Use to identify the CVP media server if it is other than the default.
- **user.microapp.locale**: Use to specify the name of the locale directory on the media server if it is other than the default (“en-us”).
- **user.microapp.app_media_lib**: Use to specify the name/path of the application directory on the media server if it is other than the default (“app”). See the Configuration and Administration Guide for Unified CVP for instructions on defining ECC variables for CVP.

---

**Unified CCE**

Deploy the files for the CVP gateways and complete configuration. You can deploy gateway templates from the CVP Management Console to the gateways.

Configure the CVP SIP subsystem, and configure the dial plan on the SIP Proxy or with the local static route configuration. This includes the routing for the dialed number used with whisper service calls.

**Unified CCX**

**Note**

This is for Parent/Child deployments only. Whisper Announcement for Parent/Child is only supported for a very specific Parent/Child configuration. Whisper Announcement in Parent/Child configurations must be approved by the Cisco Assessment to Quality (A2Q) process and require Cisco Design Mentoring Service to assure that the deployment model is designed and sized correctly to support the Whisper Announcement feature.

Configure IP-IVR on the child. Call queuing is completed on the child. For more information, see [Whisper Announcement in a parent-child deployment](#) on page 67

---

**Note**

To deploy Whisper Announcement in a Parent/Child deployment, Unified CCX (IP IVR) is required on the child. Calls are queued on the child.
Functional Limitations

Whisper Announcement is subject to these limitations:

- Whisper Announcement is not supported with outbound calls made by an agent. The announcement plays for inbound calls only.
- For Whisper Announcement to work with agent-to-agent calls, use the SendToVRU or TranslationRouteToVRU node before you send the call to the agent. The transferred call must be sent to Unified CVP before it is sent to another agent, so that Unified CVP can control the call and play the Whisper Announcement, regardless of which node is used to send the call to Unified CVP.
- Whisper Announcements do not play when the router selects the agent via a label node.
- Whisper Announcement is not supported with SIP Refer Transfers.
- Silent Monitoring (CTI OS and Unified CM-based) is supported with Whisper Announcement with this exception: For Unified CM-based Silent Monitoring, supervisors cannot hear the announcements themselves. The Silent Monitor button on the supervisor desktop is dimmed while an announcement is playing.
- Only one Whisper Announcement can play for each call. While a Whisper Announcement is playing, you cannot put the call on hold, transfer, conference, or release the call, or request supervisor assistance. These features become available again after the whisper is complete.
How Whisper Announcement works

This chapter describes how the Whisper Announcement feature works.

- Whisper Announcement Audio File, page 53

Whisper Announcement Audio File

You store and serve your Whisper Announcement audio files from the Cisco Unified Contact Center Enterprise (Unified CCE) media server. Wave (.wav) is the only supported file type. The maximum play time for a Whisper Announcement is subject to a timeout. If the timeout is reached, play terminates regardless of the actual length of the wave file. The default timeout is 15 seconds. In practice, you may want your messages to be much shorter than that, in approximately 5 seconds or less, to shorten your call-handling time.

While a Whisper Announcement Is Playing

Only one Whisper Announcement can play for each call. While a Whisper Announcement is playing, you cannot put the call on hold, transfer, conference, or release the call, or request supervisor assistance. These features become available again after the whisper is complete.

Whisper Announcement with Transfers and Conference Calls

When an agent transfers or initiates a conference call to another agent, the second agent hears a whisper, assuming that the number dialed to reach the second agent is configured to hear them. In the case of consultative transfers or conferences, while the whisper plays, the caller hears music or whatever is configured to play during hold. The first agent hears ringing. In the case of blind transfers, the caller hears ringing while the whisper announcement plays.

Whisper Announcement call flow

Following is a Whisper Announcement call flow diagram accompanied by a description of the steps.
1. CVP receives a new call from the PSTN.
2 - 3. CVP sends the new call to the VRU PIM and the VRU PIM sends the new call to the Unified CCE router.
4. If an agent is available, the router reserves the agent.
5 - 6. The router sends a label with a whisper prompt to CVP.
7. CVP sends the call to Unified CM.
8 - 9. The agent receives and answers the call.
10. Unified CM sends the established event to the agent PIM. The agent PIM holds the event until the Whisper Announcement is done playing.
11. CVP tells the VXML gateway to play ringback to the caller and the Whisper Announcement to the agent. After the Whisper Announcement plays, CVP connects the agent to the customer and notifies Unified CCE.
12. The agent PIM gets notification that Whisper Announcement is complete and sends the established event to the agent desktop.

**Whisper Announcement Reporting and Serviceability**

Whisper time is not specifically broken out in Unified CCE reports. In agent, skill group, and Precision Queue reports, the period during which the announcement plays is reported as Reserved agent state time. In the Termination Call Detail records, it is treated as Ring Time.

Serviceability for Whisper Announcement includes system events to indicate reasons for Whisper Announcement failures and counters to track the number of failed whisper events. For more information, see the Troubleshooting Unified CCE DocWiki.
Component failure and Whisper Announcement

Failover of ICME and CTI OS server

In a duplexed deployment, when a router, logger, peripheral gateway, or CTI OS Server fails over, Whisper Announcement is unaffected; Whispers play normally with no interruption. Note that when fail over occurs, reporting data on Whisper Announcements playing at that time may be inconsistent. For example, whisper time may be counted as talk time (instead of ring time, as normal).

Failure to access CVP media server

If the connection to the CVP media server fails, or if a requested whisper audio file cannot be found, the call proceeds normally without Whisper Announcement.

Whisper Announcement in Agent Desktop Software

No configuration is needed to integrate Whisper Announcement with agent desktop software. While a whisper is playing, software on the agent desktop shows the call in the Ring state. Desk phones show the call in the Talking state.

Using Agent Greeting with Whisper Announcement

You can use Agent Greeting along with the Whisper Announcement feature. Consider the following when you use them together:

• On the call, the Whisper Announcement always plays first before the greeting.

• To shorten your call-handling time, you may want to use shorter whispers and greetings than you might if you were using either feature by itself. A long whisper followed by a long greeting means a long wait before an agent handles a call.

• Usually, agents that use Whisper Announcement handle different types of calls: for example, "English, Gold Member, Activate Card, Spanish, Gold Member, Report Lost Card, English, Platinum Member, Account Inquiry." Ensure the greetings your agents record are generic enough to cover the range of customer calls they handle.
CHAPTER 10

Deploy Whisper Announcement

This chapter describes how to deploy and configure the Whisper Announcement feature in a non-Parent/Child deployment. To deploy and configure Whisper Announcement in a Parent/Child deployment, see Whisper Announcement in a parent-child deployment, on page 67

- Deployment tasks, page 57

Deployment tasks

The following list shows the high-level tasks that are required to deploy Whisper Announcement. Individual steps are covered in more detail in later sections.

1. Ensure your deployment meets the baseline requirements for software, hardware, and configuration described in the System Requirements and Limitations section. See System requirements and functional limitations, on page 49.
2. Create Whisper Announcement Audio Files, on page 57.
3. Deploy Whisper Announcement Audio Files to Media Server, on page 58.
4. Configure Whisper Service Dialed Numbers, on page 58.
5. Add Whisper Announcement to Routing Scripts, on page 60.

Example scripts that enable Whisper Announcement are installed with your system. For information about these scripts and how to access them, see Whisper Announcement Sample Scripts, on page 63.

Create Whisper Announcement Audio Files

You must create audio files for each different Whisper Announcement you want to use on your system; for example, "Sales, English" or "Soporte Técnico en Español." Create the files using the recording tool of your choice.

When recording your files, follow these rules:
• The media files must be in wave (.wav) format. Your wave files must match Unified CVP encoding and format requirements (G.711, CCITTA-Law 8 kHz, 8 bit, mono).

• To avoid cutting off files when they are played, make sure they do not exceed the Whisper Announcement play limit (15 seconds, by default).

• Test your audio files. Ensure that they are not cut off and that they are consistent in volume and tone.

• To reduce the likelihood of scripting errors, decide ahead of time on a file-naming convention that is easy for you and others to remember. For example, en_sales.wav, sp_support.wav.

**Deploy Whisper Announcement Audio Files to Media Server**

Deploy your whisper audio files to your Unified CVP media server using whatever file-transfer method you prefer. The most important consideration is where on the server to place the files. HTTP requests for media server audio files are constructed as

```
http://<media_server>/<locale_directory>/<application_directory>/<file_name>
```

The CVP defaults for the locale and application directories are `en-us/app`. Unified CCE automatically adds `en-us/app` to the server name when making HTTP requests for media files.

For example, if:

• The script node that defines the media server has a value of `http://myserver.mydomain.com`

```
and
```

• The script node that defines the audio file to play has a value of `en_sales.wav`

Then the HTTP request for the file is automatically constructed as

```
```

If you store your files in a different locale and application directory, your routing scripts must include variable nodes that define those alternate locations. Make note of the directories in which you place your files and communicate the locations to your script authors.

Make sure that the directories in which you deploy your files have the appropriate permissions to allow Read access.

**Using a Default Media Server**

Optionally, CVP lets you define a default media server. (You do this in the CVP Operations Console; see your CVP documentation for more information.) If a default media server is defined in CVP, script authors need not identify the media server in their call routing scripts provided the files that they request are available from that server.

**Configure Whisper Service Dialed Numbers**

For Whisper Announcement, Unified CVP uses two different dialed numbers when transferring a call to an agent:

• The first number calls the ringtone service that the caller hears while the whisper plays to the agent. The CVP default for this number is 91919191.

• The second number calls the whisper itself. The Unified CVP default for this number is 9191919100.
Whisper Announcement dialed number is always an extension of Ringtone dialed number extra two zeros at the end.

For Whisper Announcement to work, your dial plan must include both of these numbers. The easiest way to ensure coverage is through the use of wild cards such as 9191*.

**Configure Dialed Numbers**

You configure the dialed numbers for Whisper Announcement in the Unified CVP Operations Console at System > Dialed Number Pattern > Add new. For the Dialed Number Pattern Types, select Enable Local Static Route. Once Enable Local Static Route is checked, select either Route to Device or Route to SIP Server Group for VXML gateways. Then save and deploy the dialed number.

It may be necessary to override the dialed number plan for the default Whisper DN, if the default DN conflicts with the overall dial number plan. To override the DN pattern from the SIP subsystem level in CVP OAMP:

**Procedure**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Select Device Management &gt; Unified CVP Call Server.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Select the Call Server on which to override the default whisper DN.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Select the SIP tab.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Override the default value of 91919191 configured under the DN on the Gateway to play the ringtone field.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Click Save &amp; Deploy.</td>
</tr>
</tbody>
</table>

**Configure Ringtone Dialed Number**

To configure the Ringtone dialed number in the CVP Operations Console:

2. Select the Call Server on which you want to configure the settings.
3. Select the SIP tab.
4. In the DN on the Gateway to play the ringtone field, configure the default Ringtone dialed number Pattern.

**Dialed Number in the Dial-Peer**

In addition to configuring the dial plan in Unified CVP, examine your IOS dial-peer. Make sure that the dialed number setting in your dial-peer configuration accommodates both of the whisper service dialed numbers.
Add Whisper Announcement to Routing Scripts

To enable Whisper Announcements, use the Script Editor to modify your routing scripts as follows:

• Specify the WhisperAnnouncement call variable
• Specify the Unified CVP media server and location of whisper audio files
• Specify other required variables

For more information, see Whisper Announcement Sample Scripts, on page 63.

Specify WhisperAnnouncement Call Variable

To include Whisper Announcement in a script, insert a Set Variable node that references the WhisperAnnouncement call variable. The WhisperAnnouncement variable causes a whisper to play and specifies the audio file it should use. Typically, you use a single whisper prompt for a single call type. As a result, you use only one WhisperAnnouncement set node for each script. However, as needed, you can set the variable at multiple places in your scripts to allow different announcements to play for different endpoints. For example, for skills-based routing, you can specify the variable at each decision point used to select a particular skill group or Precision Queue.

**Note**

Only one Whisper Announcement can play for each call. If a script references and sets the WhisperAnnouncement variable more than once in a single path through a script, the last value to be set is the one that plays.

Use these settings in the Set Variable node for Whisper Announcement:

• Object Type: Call.
• Variable: Must use the WhisperAnnouncement variable.
• Value: Specify the filename of the whisper file. For example: “my_whisper.wav” or “my_whisper”.
  • Specify the filename only, not its path.
  • You must enclose the filename in quotation marks.
  • The filename is not case sensitive.
  • The filename cannot include spaces or characters that require URL encoding.
  • The .wav extension is optional. If you omit it, Unified CVP adds it automatically in the HTTP request.

Specify Unified CVP Media Server Information

If you define a default media server in your CVP Operations Console and it is the server from which you serve your whisper files, then you need not specify the media server in your routing scripts. However, if you do not define a default media server, or if you store your whisper file on a server other than the default, then your scripts must include a Set Variable node that identifies that server.
To specify your media server, use the following settings in the Set Variable node:

- **Object Type:** Call.
- **Variable:** Must use the user.microapp.media_server ECC variable.
- **Value:** Specify the HTTP path to the server. For example: "http://myserver.mydomain.net." You must enclose the path in quotes.
- Alternately you can specify an IP address in place of a DNS. Include the listening port number if the media server web server listens on a port other than 80 (for HTTP) or 443 (for HTTPS).

### Specify Whisper File Locale and Application Directories

CVP uses a default storage directory for media files: `<web_server_root>/en-us/app`. To take advantage of this, Unified CCE call routing scripts automatically add "en-us/app," to the server name when constructing HTTP requests for media files. For example:

- If the script node that defines the media server has a value of "http://myserver.mydomain.com" and...
- The script node that defines which audio file to play has a value of "en_sales.wav," then...
- The HTTP request for the file is automatically constructed as


If your whisper audio files are stored in a different locale directory, you must add a Set Variable node to your script that identifies the locale directory. Similarly, if your whisper files are stored in a different application directory, you must add a Set Variable node that identifies that directory.

**Specify locale directory**

Use these settings in the Set Variable node to specify your locale directory:

- **Object Type:** Call.
- **Variable:** Must use the user.microapp.locale ECC variable.
- **Value:** Specify the directory name. For example: "pt-br," You must enclose the path in quotes.

**Specify application directory**

Use these settings in the Set Variable node to specify your application directory:

- **Object Type:** Call.
- **Variable:** Must use the user.microapp.app_media_lib ECC variable.
- **Value:** Specify the directory name. For example: to use a directory "wav_files" in place of the default directory "app," enter "wav_files." To use a sub-directory "wav_files" "app," enter "app/wav_files." You must enclose the path in quotes.

**Variable length for media server locale and application directory variables**

If you do include Set Variable nodes for the media server, locale, or application directories, ensure that the values you set for them do not exceed the Maximum Length settings for their corresponding ECC variables.

For example, if you include a Set Variable node for the media server with a value of "http://mysubdomain.mydomain.co.uk," the string is 33 characters long. Therefore, the Maximum Length setting for the user.microapp.media_server ECC variable must be 33 or greater. If it is not, you must increase
the Maximum Length setting. Otherwise, the server name is truncated in the HTTP request for the file and
the file is not found. You configure ECC variables in the Unified CCE Configuration Manager at List Tools
> Expanded Call Variables List.

Test Whisper Announcement File Path

To test the path to the whisper file that you defined in your script variables, enter the complete URL into a
browser. The wave file should play. For example:

- If your script includes: default media server + default locale + default application directory + whisper.wav,
  then the path is "http://<default_media_server>/en-us/app/whisper.wav"
- If your script includes: http://my_server.my_domain.com + default locale + "app/wav_files" +
  whisper.wav, then the path is "http://my_server.my_domain.com/en-us/app/wav_files/whisper.wav"

Other Script Settings That Are Required for Whisper Announcement

These additional settings are required for Whisper Announcement to work:

- Enable Target Requery on all script nodes that follow the WhisperAnnouncement variable and target
  an agent. These include Queue (to Skill Group or Precision Queue), Queue Agent, Route Select, and
  Select. If Target Requery is not enabled, the Whisper Announcement does not play.
- When you run an agent transfer or a conference script, use a SendtoVRU, a TranslationToVRU, or a
  Run Script Request node before you target an agent.

Configure Whisper Announcement Play Length

This section contains information about configuration options that you can use to fine-tune Whisper
Announcement.

Fail-Safe Timeout for Whisper Announcement in Unified CCE

Unified CVP sends one message to Unified CCE each time a Whisper Announcement begins and a second
message when the announcement ends. The time stamps from these messages are used to calculate Whisper
Announcement data in Unified CCE reports.

If Unified CVP fails to send a Whisper Announcement end message to Unified CCE, the following occurs:

- Unified CCE cannot accurately calculate the whisper length, thus skewing report data.
- The agent cannot control the call (for example, put it on hold or transfer it) because these controls are
  disabled while a Whisper Announcement is playing.

To prevent this, Unified CCE has a Whisper Announcement timeout setting. The value for this setting represents
the maximum Whisper Announcement play time that Unified CCE uses to calculate its report data.

The default is 20 seconds. This default is based on the default Whisper Announcement play time (specified
in Unified CVP) of 15 seconds. The extra 5 seconds in the Unified CCE fail-safe timeout is a buffer against latency. If you modify the maximum Whisper Announcement play time in Unified CVP, modify the Unified
CCE Whisper Announcement fail-safe timeout accordingly.
The Unified CCE Whisper Announcement fail-safe timeout value should be equal to or (preferably) greater than the maximum Whisper Announcement play time setting in Unified CVP. Otherwise, Whisper Announcement play time in Unified CCE reports are under-reported.

To change the fail-safe timeout value, complete the following steps:

**Procedure**

**Step 1** In Unified CCE Configuration, select Tools > Explorer Tools > PG Explorer.

**Step 2** Select Retrieve to return a list of PGs (Peripheral Gateways).

**Step 3** Double-click the PG with the Generic client type (for example, Generic_PG). The Generic PG has four VRU Peripherals associated with it.

**Step 4** Select the first VRU Peripheral listed.

**Step 5** On the Peripheral tab, enter the following text in the Configuration Parameters field:

/WHSTMOUT <value in seconds>

**Step 6** Repeat this process for all of the listed VRU Peripherals.

**Step 7** Once you are finished, select Save.

---

**Whisper Announcement Sample Scripts**

Unified CCE includes sample routing scripts that demonstrate Whisper Announcement. You can use them as learning tools and as models for your own Whisper Announcement scripts. They are the following:

- **WA.ICMS**—This script plays a Whisper Announcement.

- **WA_AG.ICMS**—This script plays both a Whisper Announcement and an Agent Greeting to play on the same call flow.

The script files are located in the \c:\icm\bin directory. In Unified CCE Script Editor, they are installed to the application root directory.

**Note** To use these scripts you must have a default media server configured in Unified CVP, and have the Whisper file stored in the default location on the media server. For that reason, they do not include variables that specify the media server, locale, or application directories.

**WA.ICMS Script**

This script sets up a Whisper Announcement by setting the Whisper Announcement variable to the desired wave file and then queuing the call to a skill group or Precision Queue. After an agent is selected from the skill group or Precision Queue and the call routed to the agent, the whisper plays to the agent.
WA_AG.ICMS Script

This script causes both a Whisper Announcement and an Agent Greeting to play.

Import Sample Whisper Announcement Scripts

To view or use the sample Whisper Announcement scripts, you must first import them into Unified CCE Script Editor. Follow this procedure to import the scripts:

Procedure

Step 1 Open Script Editor.
Step 2 Select File > Import Script and select the first of the two scripts to import.

In addition to importing the script, Script Editor tries to map imported objects. Some objects that are referenced in the sample scripts, such as the external Network VRU scripts or the skill groups or Precision Queues, do not map successfully. You must create these maps manually or change these references to point to existing Network VRU scripts, skill groups, and Precision Queues in your system.
Step 3  Repeat steps 2 and 3 for the remaining script.
Whisper Announcement in a parent-child deployment

To use Whisper Announcement in a parent-child deployment, you must configure it on a system PG using Cisco Unified Contact Center Express (CCX). Unified CCX (IP-IVR) is required on the child where call queuing occurs.

Note

Whisper Announcement for Parent/Child is only supported for a very specific Parent/Child configuration. Whisper Announcement in Parent/Child configurations must be approved by the Cisco Assessment to Quality (A2Q) process and require Cisco Design Mentoring Service to assure that the deployment model is designed and sized correctly to support the Whisper Announcement feature.

Within a child, Whisper Announcement plays for:

* incoming calls not initiated by an agent on the same child
* single-step and blind consultative transfers to an agent on the same PG where the call is queued before the call is answered

Note

Blind consultative transfer is where the transferring agent completes the transfer before the consulted agent answers.

* inbound and transfers/conferences to an agent on a different child

Whisper Announcement always plays to an agent when a call originates from outside the Cisco Unified Call Manager that answers the call. The same behavior occurs when the call is transferred or conferenced and the transfer or conference initiator is not registered to the same Cisco UCM that answers the call. For all other scenarios, Whisper Announcement does not play. Some businesses may choose to disable Whisper Announcement in all transfers for consistency purposes (the feature is controlled through scripting).

If a caller hangs up on an incoming call while whisper announcement plays to an agent, a three-second delay occurs before the cleared call is reported and the agent desktop is updated. The purpose of this delay is to distinguish between an abandoned call or just the completion of the whisper announcement.

If an agent hangs up the hard phone while whisper announcement plays, the incoming call is routed to the phone of that agent and the call is auto-answered.
Whisper announcement in a parent-child deployment is supported with both local and mobile agents.

**Note**
Peripheral call variables are not preserved by the system PG after a call is sent to Post Route Trigger.

- Functional limitations, page 68

## Functional limitations

Whisper Announcement (in a Parent-Child deployment) is subject to the following limitations:

- A call must be sent to Unified CCX before the call is sent to the targeted agent, regardless if the call requires queueing.
- Calls that are routed to an agent using the Label node are not supported.
- Calls that originate from one System PG when the targeted agent is on a different System PG on the same child are not supported.

## Configure Whisper Announcement in parent-child deployment

### Before You Begin

- Configure CTI Ports
- Ensure that IP-IVR is working with ICM
- Ensure that IP-IVR can queue the call for ICM
- Configure a “Send to VRU” node

### Procedure

**Step 1** Configure two ECC variables for user.whisper and user.media.id.
See Configure user.whisper and user.media.id ECC variables, on page 69.
**Note** Configure the user.media.id on the child, not the parent.

**Step 2** Enable Agent Whisper.
See Enable Whisper Announcement, on page 69.

**Step 3** Configure the routing script.
See Configure routing script, on page 70.

**Step 4** Upload the whisper prompt .wav file.
See Upload Whisper prompt .wav file, on page 71.

**Step 5** Configure the ring tone for Network Audio Source.
See Upload ringtone, on page 71 and Configure Network Hold Audio source, on page 72.

**Step 6** Configure the timeout for Whisper Announcements.
Configure user.whisper and user.media.id ECC variables

Complete the following procedure to configure the user.whisper and user.media.id ECC variables.

Note

Configure the user.media.id variable on the child, not the parent.

Before You Begin

The details of the user.whisper ECC variable are as follows:

- Name: user.whisper
- Datatype: 40 character string

The details of the user.media.id ECC variable are as follows:

- Name: user.media.id
- Datatype: 40 character string

Procedure

Step 1 Log into Cisco Unified Contact Center Enterprise.
Step 2 Click Start > All Programs > Cisco Unified CCE Tools > Administration Tools > Configuration Manager.
Step 3 In Configuration Manager, expand Tools.
Step 4 Double-click Expanded Call Variable List.
Step 5 In the name box, type the name of the variable.
Step 6 In ECC variable attributes, check the enabled box.

Note The user.whisper and user.media.id ECC variable names are case sensitive.

Enable Whisper Announcement

Complete the following steps to enable Whisper Announcement.
Procedure

Step 1 Launch Cisco Unified CCX Administration.
Step 2 Enter username in Username box.
Step 3 Enter password in Password box.
Step 4 Click Login.
Step 5 Select Subsystem > ICM > General.
   The ICM configuration page appears.
Step 6 In the Additional VRU call information section, check Media ID and Whisper Announcement check boxes.
Step 7 Click Update.

Configure routing script

Before You Begin

- Configure the ECC variables.
- Ensure that a Routing Script is created and uploaded.

Procedure

Step 1 Log into UCCE.
Step 2 Select Start > All Programs > Cisco Unified CCE Tools > Administration Tools > Script Editor.
Step 3 Select the routing script to modify.
Step 4 Add a Set Variable node in the routing script.
   Use the following settings for the Set Variable node:

   **Object Type**
   Call

   **Variable**
   Use the user.whisper ECC variable

   **Value**
   Specify the directory name of the whisper file.
   For example, "wav_files". To use a sub-directory wav_files in app, enter "app/wav_files".
   You must enclose the path in quotation marks.

Step 5 Set user.whisper to whisper prompt file name.
Step 6 Add Send to VRU node before the Queue node.
Step 7 Click Update.
Upload Whisper prompt .wav file

**Note**
The length of Whisper Announcement prompt file should be less than the maximum configurable Whisper Announcement timeout value. If the length of Whisper Announcement prompt file exceeds the maximum Whisper Announcement configurable timeout value, when Whisper announcement times out, the incoming call is redirected to agent and the call is auto-answered.

**Before You Begin**
- Configure the ECC variables.
- Enable Agent Whisper.
- Configure the routing script.

**Procedure**

**Step 1**
In Cisco Unified CCX Administration, choose Applications > Prompt Management.

**Step 2**
Click Upload Prompts.
The Upload Prompt window appears.

**Step 3**
Select the file location.
- Type the name of the .wav file in the File Name box.
- Click Browse to browse to the file location.

**Step 4**
Click Upload.

**Upload ringtone**

Configure the ring tone to be played to the caller when Whisper Announcement is played to the agent.

**Procedure**

**Step 1**
Launch the Cisco Unified CM Console.

**Step 2**
Enter username in Username box.

**Step 3**
Enter password in Password box.

**Step 4**
Select Media Resources > MOH Audio File Management.

**Step 5**
Select .wav file to upload.

**Step 6**
Click Upload File.
The Upload File Window appears.

**Step 7**
In the Upload File box, enter file name OR click Browse to browse to the file location.

**Step 8**
Click Upload.
Configure Network Hold Audio source

**Before You Begin**

- Configure and upload a ringtone.
- Configure a Call Control Group.
- Upload the ringtone .wav file.

**Procedure**

**Step 1** Select Subsystems > Cisco Unified CM Telephony > Call Control Group from the Cisco Unified CCX Administration menu. The Cisco Unified CM Telephony Call Control Group Configuration page appears.

**Step 2** Select the CTI Port to modify.

**Step 3** Choose the ringtone media source from the Network Hold Audio Source list.

a) (Optional) Click Show More if the Network Hold Audio list does not appear in the window.

**Step 4** Click Update.

Configure timeout for Whisper Announcement

Complete the following steps to configure the timeout length for Whisper Announcements.

**Procedure**

**Step 1** Log into UCCE.

**Step 2** Select Start > All Programs > Cisco Unified CCE Tools > PG Explorer > Peripheral(tab) > Configuration Parameters (field).

**Step 3** Click Peripheral tab.

**Step 4** Enter /WHSTMOUT \(<n>\) in Configuration Parameters box where \(<n>\) is the time in seconds.

**Example:**

/WHSTMOUT 20

The default value is 20.